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Configuring a Release Management System
 Chapter

Introduction

Mercury Release Management provides an interface for grouping and 
processing the Packages and Requests associated with a specific Release. 
Release Management introduces repeatable, reliable processes surrounding 
software and application releases. Groups of related Packages can then be 
activated from a single window. 

Using Release Management, Release Managers can:

• Group related Packages and Requests in a single window

• Provide visibility into related Package statuses

• Set dependencies between Packages

• Define how a Release is distributed to different Environments

This consolidation of common Release Management activities provides a 
powerful tool for creating repeatable and reliable Releases.

Demand Management allows an organization to model its processes for 
managing technology initiatives from inception to implementation using a 
graphical workflow business modeler. Complex business rules can be modeled 
using approval methods and prioritization features that allow issues to 
efficiently advance through their specific workflow, routing them to relevant 
departments, groups or individuals. Demand Management is designed to 
capture data by prompting users for information specific to their “Request,” 
ensuring that required information is collected and validated at the appropriate 
time in the process.
Introduction 1
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About This Document
This guide provides instructions for configuring a Release Management 
system. This includes requirements gathering, modeling your processes in a 
Workflow, defining commands used by the execution engine, and rolling out 
this system to your users.Each chapter covers a particular topic:

Intended Audience
The intended audience for this document include:

• Business or technical users who configure and maintain a deployment 
system using Mercury Change Management

• Managers responsible for reporting on software and application 
deployments

• Users responsible for deploying software and applications using Change 
Management

• Release Managers

• Release Managers

Key Concepts Defines the key concepts and definitions used when 
creating a Release Management system.

Modeling Your Release Process in 
Release Management

Provides an overview of how to use Workflows to model 
your Release processes in Release Management. 

Creating a Release Explains how to create a Release and add Packages to it.

Processing a Release Describes how to move a Release from creation to 
completion.

Viewing Relevant Release Data Explains how to view only relevant Release data.

Release Management Screens and 
Fields

Defines the key screens and fields used in Release 
Management.
2 Introduction
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Document Conventions
Table 1-1 lists the types of conventions used in this document.

Additional Resources
Mercury Interactive provides the following additional resources to help you 
successfully configure the Mercury products:

• Related Documentation

Table 1-1. Document conventions

Convention Description Example

Button, menu, tabs Names of interface components that can be 
clicked (such as buttons, menus, and tabs) 
are shown in bold.

Apply button

Fields, Windows, Pages Names of windows, fields, and pages are 
shown as displayed.

New Request window

Code Code input and output are shown as 
displayed.

CauchoConfigFile 
C:/ITG_Home/conf/
resin.conf

Link Linked URLs, filenames, and cross references 
are shown as blue italicized text.

www.mercury.com

Variable Variables are shown as italicized text. ITG_Home/bin directory

Note Used to identify note boxes that contain 
additional information.

Caution Used to identify caution boxes that contain 
important information. Follow the instructions 
in all caution boxes, failure to do so may result 
in loss of data.

Example Used to identify example boxes that contain 
examples of related procedure.
Introduction 3
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• Customer Support

• Education Services

Related Documentation
The Library includes additional documents related to the topics discussed in 
this guide. Access the Library through the Mercury ITG Center online help.

Using the Dashboard This document provides details for defining 
and configuring the Dashboard and custom 
Portlets.

Processing Requests (Demand 
Management)

This document explains how to process 
Requests using Demand Management.

Processing Packages (Change 
Management)

This document explains how to process 
Packages using Change Management.

Using the Workbench This document explains how to navigate 
through the Workbench interface.

System Administration Guide This document provides information 
necessary to implement, configure, and 
maintain Mercury ITG Servers.

Migrators Guide and 
Reference

This document provides details for 
configuring and using the Mercury ITG 
Migrator Object Types to migrate or archive 
data from Mercury ITG Center instances.

Commands and Tokens Guide 
and Reference

This document provides information on using 
commands and Tokens.

Security Model Guide and 
Reference

This document presents an overview of the 
data security model and provides instructions 
for controlling access to different entities.

Configuring a Request 
Resolution System

This document provides instructions for 
configuring a Request resolution system. This 
includes requirements gathering, modeling 
your processes in a Workflow, defining a 
Request Type to be integrated with the 
Workflow, and rolling out this system to your 
users.
4 Introduction
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Customer Support
Customer support and downloads for the Mercury ITG Center and additional 
product information can be accessed from the Mercury Interactive Support 
Web site at http://support.mercuryinteractive.com.

Education Services
Mercury Interactive provides a complete training curriculum to help you 
achieve optimal results using the Mercury IT Governance Center. For more 
information, visit the Education Services Web site at http://www.merc-
training.com/main/ITG.

Configuring the Dashboard This document provides instructions for 
configuring custom Portlets, maintaining 
standard and custom Portlets, and setting a 
Default Dashboard for all users.

Reports Guide and Reference This document provides details for running 
reports.

Open Interface Guide and 
Reference

This document provides details for integrating 
third-party products with Mercury ITG Center 
entities.

Customizing the Standard 
Interface

This document provides details for 
customizing the standard interface, including 
the directory structure and methods of 
customization for changing the presentation 
of the standard interface.
Introduction 5
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 Chapter

Key Concepts

The following Release Management concepts and definitions will help you 
create and deliver a successful software or application Release:

• “Release” on page 7

• “Distribution” on page 8

• “Release Manager” on page 9

• “Security and Access Grants in Release Management” on page 9

• “Role of Workflows in Release Management” on page 10

• “Dependencies and Run Groups” on page 14

• “Open Release” on page 15

• “Submit Release” on page 16

• “Using Release Management - Process Overview” on page 16

Release
A Release is a group of Packages (and related Requests) that need to be 
deployed together. Release Management provides an interface through which 
users can group, view and execute these Packages. Packages can be added to a 
Release either by a Ready for Release Step in the Package Workflow or by the 
Release Manager through the Release window. 
Key Concepts 7



Configuring a Release Management System
Distribution
A Distribution is a deployment of a Release. In a Distribution, the Release 
Manager specifies which Workflow will control the Release process and which 
of the Release’s Packages will be included. See “Role of Workflows in Release 
Management” on page 10 for more information.

A software company has a product update release scheduled five months 
from now. In order to ensure a smooth product delivery, they decide to track 
all changes to their original code using Release Management. As developers 
complete their Packages, those Packages are included in a Release and 
processed together. By grouping every required change in the Release, the 
company is able to quickly and easily assess the state of the product delivery.

A software company has a product update release scheduled five months 
from now. As a part of their Release process, they need to update their 
Testing, Production, and Training instances of the product. The processes 
required for delivering the product to these different Environments differs in 
the following ways:

• Not all of the Packages in the Release need to be applied to each instance 
(the Training instance requires custom code to establish additional 
product security which is not required in the Production instance).

• There is a different review process for each instance (the Testing instance 
does not require the department head sign-off for each iteration of the 
Release).

The software company creates a Distribution for each of these Release 
instances. For each Distribution they define:

• Which Packages are included in the specific Release instance.

• Which process (Workflow) the Release follows.
8 Key Concepts
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Release Manager
The Release Manager is the person who is responsible for overseeing and 
executing the delivery of an application or software Release. The Release 
Manager is specified in the Release Manager field on the Release window in the 
Workbench. 

This user can add Packages and Requests to the Release, set dependencies, and 
create and process Release Distributions. The Release Manager is also 
typically involved in the configuration of relevant Workflows; in particular, 
they manage the Release Distribution Workflows. 

Security and Access Grants in Release Management
Release Management has defined the following Access Grants that can be used 
to view, manage, and edit Releases.

Table 2-1. Release Management Access Grants

Access Grant Description

Change Management: 
View Releases

Users with this Access Grant can view any Release in 
Release Management. They can also act on any 
Distribution Workflow Steps where they are included 
in the Step’s security. 

Change Management: Edit 
Releases

Users with this Access Grant can: 

• View any Release

• Be designated as the Release Manager in the 
Release window

• Create Releases

• Edit or delete any Release that they created

• Act on any Distribution Workflow Steps where 
they are included in the Step’s security. 

• Edit or delete a Release that they did not create 
(only when they are designated as the Release 
Manager in the Release Management window). 
Key Concepts 9
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Role of Workflows in Release Management
Release Management Workflows are used in two key areas of a Release:

• Defining a process by which Packages are added to a Release using a 
Ready for Release Workflow Step

• Defining the Distribution process

The following sections discuss the applications of Workflows in a Release:

• “Workflow Scope” on page 10

• “Release Management and Package Workflows” on page 11

• “Release Distribution Workflows” on page 12

• “Package Level Subworkflows” on page 13

Refer to the Workflow chapter in Configuring a Deployment System (Change 
Management) for details on Workflow configuration.

Workflow Scope
Each Workflow has an associated Workflow Scope. The Workflow Scope 
determines which Release Management entities can be processed through that 
Workflow. The Workflow Scope can be one of the following:

• Packages

• Requests

• Release Distributions

Change Management: 
Manage Releases

Users with this Access Grant can:

• Create a Release

• Be designated as the Release Manager in the 
Release window

• Edit or delete any Release (regardless of whether 
they are specified as the Release Manager in the 
Release Management window).

Table 2-1. Release Management Access Grants

Access Grant Description
10 Key Concepts
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Release Management uses Workflows with “Packages” and “Release 
Distribution” scopes. 

Release Management and Package Workflows
You can configure your standard Package Workflows to feed Packages into a 
Release. A Ready for Release Workflow Step can be included in the Package 
Workflow. When a Package Line enters the Ready for Release Step, the 
developer (or other Release Management user responsible for that Package) 
can select which Release they would like to add the Package to. The user 
selects the Release and adds the Package and its associated Package Lines to 
the Release. When all of the Package Lines are confirmed in the Ready for 
Release Step, the Package is ready to be used in the Release. 

Figure 2-1 illustrates the process by which developers can add Packages to a 
Release.

Figure 2-1 Ready for Release Step in Change Management Workflow

Certain Workflow configuration restrictions are enforced by the Workflow 
Scope. For example, Release Distribution Workflows can not include the 
wf_jump and wf_receive Workflow Events. For more information on 
configuring Distribution Workflows, see “Modeling Your Release Process in 
Release Management” on page 19.

Package Line 1 _________
Package Line 2 _________
Package Line 3 _________
Package Line 4 _________

Change Mgmt
Package

Package Lines are run
though Package Workflow

Change Mgmt (Package) Workflow

Step 1
Package
Process

Step 2
Package
Process

Step N
Package
Process

Development Process

Ready for Release

Release Management Step

Packages can follow standard
Development process defined by
Engineering team.

When Package Line enters the Ready
for Release step, that Package Line can
be automatically included in a Release.
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Release Distribution Workflows
Just as the inclusion of appropriate Packages and Requests is integral to the 
Release definition, so is the process by which the Packages are processed in a 
Release Distribution. Distribution Workflows are used to define the process by 
which the Release’s Packages are properly tested, approved, and executed 
against any required Environments.

Release Distribution Workflows need to include Package Level Subworkflows 
to perform key Package level processing. All Package Line (Object Type) 
execution will occur in the Subworkflow.

Figure 2-2 illustrates the relationships between basic Change Management 
Packages and Release Workflows.

Figure 2-2 Role of the Distribution Workflow

The Release Distribution Workflow provides a way in which the Release 
Manager can ensure that all files associated with the Release deploy properly. 
As with any Workflow, the Distribution Workflow can be configured to model 
your existing or best-practice Release processes.

Approve Dev ->
Test

QA
-

Signoff
Test ->

Prod

Change Mgmt (Package) Workflow — Not configured for Release Management

(Feeds into the Release Distribution
Workflow)

Close

Approve Dev ->
Test

QA
-

Signoff

Ready
for

Release
Close

Release
Approved

Test -> Pre-Prod
(Staging)

QA
(Assembly

Testing)

Pre-Prod -
>

Production
Close

Change Mgmt (Package) Workflow -- Using the Ready for Release step

Release Distribution Workflow

You can manage this
step using Release
Management. See
below.

(Feeds back into Package
Workflow)
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Package Level Subworkflows
Release Distributions include Package Level Subworkflows, which are used to 
perform key Package level processing. Package Level Subworkflows are any 
Package Subworkflows that have the Use in Release Distributions flag set to Yes. 
All Package Line (Object Type) execution will occur in these Subworkflows. 
Also, all Package and Package Line Tokens will be resolved when traversing 
through these Workflows.

Distribution

Package 1
     Package Line 1 _________
     Package Line 2 _________
     Package Line 3 _________
     Package Line 4 _________

Package 2
     Package Line 1 _________
     Package Line 2 _________
     Package Line 3 _________
     Package Line 4 _________

3. Return to processing the
Distribution as a unit (until the next
Package-Level subworkflow).

2. When the Distribution hits a
Package-Level subworkflow,
each Package Line is processed.

1. Distribution moves through the
Release Distribution Workflow as
a single unit.
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Package Level Subworkflows are used within Release Distribution 
Workflows. The Release Distribution Workflow is typically used for Release 
approvals and executing system commands (such as starting or stopping 
servers). The Distribution is processed as a single unit as it proceeds through 
the Release Distribution Workflow. When the Distribution hits a Package-
Level subworkflow, each Package Line within the Distribution is processed. 
The Package Subworkflows are used to process Package Lines and execute 
Object Type commands. 

Dependencies and Run Groups
Within a Release, the Release Manager can configure the order in which the 
Packages are processed. The Release Manager can select certain Packages to 
run before or after other Packages in the Release. The ordering of Packages 
segregates them into “Run Groups.” When a Distribution enters an Execution 
Step in a Package-Level Subworkflow, all Packages Line in the first Run 
Group will be executed before the Package Lines in the next Run Group can 
begin.

Run Groups are automatically determined as you set dependencies between 
Packages. Run Groups present an efficient way to process Packages which can 
be run in parallel without having to serially wait for non-related dependencies. 
Figure 2-3 illustrates how Package Dependencies result in different Run 
Groups.

Run Groups are automatically determined when a Release Distribution is 
created, based on Package dependencies specified in the Release. 
14 Key Concepts
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Figure 2-3 Dependencies and Run Groups

Open Release
When a Release Manager first creates a Release, only Release Management 
users with permission to edit the Release window can add Packages. The 
Release Manager can enable other users to add Packages to the Release by 
clicking the Open Release button on the Release window. By creating an Open 
Release, Developers processing a Ready for Release Step (in a Change 
Management Package Workflow) will have the option of adding the Package 
to that Release. If a Release is not opened, it will not appear in the list used for 
that Ready for Release Step.

Package 1
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Package 3
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Dependency
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Package 1

Package 3

Run Group 1
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Run Group 2

Package 2 must be
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run after Run Group 2.

Package 4
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Submit Release
When a Release Manager submits a Release, the Release enters a code freeze 
state. In this state, Packages cannot be added or removed from the Release by 
anyone other than the Release Manager. When the Release is submitted, a 
Distribution is automatically created. You can then process the Distribution or 
cancel it and create a new one later. 

Using Release Management - Process Overview
Release Management introduces repeatable, reliable processes surrounding 
software and application releases. Release Management provides an interface 
for grouping and processing the Packages and Requests associated with a 
specific release. 

The following sections provide an overview for creating a Release:

• “Release Management Pre-Configuration” on page 16

• “Creating the Release” on page 17

• “Processing the Release” on page 17

Release Management Pre-Configuration
Planning for an application or software Release should begin immediately 
upon recognition that a Release is pending. Before the Release Manager 
creates a Release, it is often necessary to pre-configure the following in 
Release Management:

1. Modify Package Workflows to include the Ready for Release Workflow 
Step

2. Create all required Distribution Workflows (including all Package-Level 
Subworkflows)

By adding the Ready for Release Step to Change Management (Package) 
Workflows, you provide developers with the ability to add a required Package 
to a Release at the appropriate time. Development Package Workflows will 
typically address necessary approval and Execution Steps directly related to 
that Package. The Ready for Release Step indicates that the developer has 
signed-off on the Package and the Package is ready to be integrated and 
shipped with other Packages related to the Release. See “Configuring 
16 Key Concepts
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Packages to Feed into a Release” on page 23 for instructions on creating the 
Ready for Release Step.

The Release Manager should also create the Distribution Workflows. This 
includes defining any Subworkflows (Package level or Distribution level) that 
will be used in the Release Distribution Workflow. These Workflows define 
the process by which the Release’s Packages are properly tested, approved, 
and executed against any required Environments. The Release Distribution 
Workflow and associated subworkflows ensure that all files associated with 
the Release are properly deployed. As with any Workflow, the Distribution 
Workflow can be configured to model your existing or best-practice Release 
processes.

Creating the Release
To create a Release in Release Management:

1. Create a new Release in the Release window. (See “Establishing a 
Release” on page 31 for additional details.)

2. Open the Release by clicking the Open Release button. This allows 
developers working in the Change Management Package window to add 
Packages to the Release via the Ready for Release Step.

3. Add Packages and Requests to the Release. Packages can be added through 
the Ready for Release Step in the Packages window or directly by the 
Release Manager through the Release window.

4. Configure Dependencies between Packages in the Release. Click the 
Dependencies button on the Package tab to set Package dependencies.

5. Verify the Release. See “Verifying the Release” on page 41 for additional 
details.

Processing the Release
When the appropriate data is collected in the Release (Packages, Requests and 
Dependencies) and the appropriate Workflows have been created, the Release 
Manager can then process the Release.

To process a Release the Release Manager will:

1. Submit the Release.
Key Concepts 17
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a. Create a Distribution. This consists of selecting a Workflow for the 
Distribution and disabling any Package Lines that you do not want run 
with that Distribution.

b. Submit the Distribution.

2. Send feedback to Packages. You can send feedback to the Packages at any 
time from the Distribution window. Select the value from the Feedback 
drop down list and click Feedback -->. This value is sent back to the 
Package Line in the Ready for Release Step and is used to transition out of 
that Step.

3. Close the Release only if you do not need to create additional Distributions 
for use at a later date.

• When the Release is closed, any in-progress Distributions are cancelled.

• If a Distribution has not been submitted, it will not be cancelled when the 
Release is closed. However, after the Release is closed the Distribution 
cannot be edited.
18 Key Concepts
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 Chapter

Modeling Your Release Process in
Release Management

You can model your Release processes using the Mercury ITG Center’s 
Workflow engine. When creating your process, you should consider the full 
range of Release Management’s functionality. The following sections provide 
a summary of the Workflows used to create a robust Release Management 
solution. They also provide detailed instructions on creating different 
Workflow-related parts of your solution.

• Release Management Workflow Overview and Restrictions

• Workflow Design Considerations 

• Configuring Packages to Feed into a Release 

• Defining a Release Distribution Workflow 

• Defining Package-Level Subworkflows for Use in Release Distribution 
Workflows 

• Adding Subworkflows to Distribution Workflows 

Release Management Workflow Overview and 
Restrictions

Before you begin to build your Release Distribution and Package Workflows, 
consider the following Workflow components that can be used to build the 
overall process.
Modeling Your Release Process in Release Management 19



Configuring a Release Management System
• Package Workflows that feed into the Release Distribution Workflow at a 
Ready for Release Step

• Release Distribution Workflow

o Distribution-Level Subworkflow

o Package-Level Subworkflow

The following diagram illustrates the relationship between these items. This 
section details common processes executed in each type of Workflow. It also 
lists any restrictions related to each type of Workflow definition. For example, 
Release Distribution Workflows can not execute Object Type commands. 
Understanding these restrictions will help you to design a functional set of 
Release-related Workflows.
20 Modeling Your Release Process in Release Management
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Release Distribution Workflow:
Defines the overall release distribution process. Can
include two types of Subworkflows: Distribution-Level and
Package-Level.

Release Distribution Workflows can be used to:
* Perform approvals
* Execute system commands such as:

o Start and stop servers
o Check out files from your source control
o Compile code
o Sign archives
o PL/SQL function, SQL statement, and
   Workflow Commands

Distribution-Level Subworkflow:
Used to simplify the graphical layout of your
Distribution. Each Distribution Subworkflow can
perform the full range of Distribution Workflow
operations.

Package-Level Subworkflow:
Used to process the Package Lines included in
a Release. They can be used to:

* Process Package Lines through a
   standard Release process
* Execute Object Type commands
* Deploy software changes defined at the
   Package Line level

Package Workflows include a “Ready for Release” Workflow Step:
Package Workflows can be configured to include a Workflow Step that will enable
Deliver users to add Packages to a Release. When Package Lines enter the Ready for
Release step, the Package can be added to a Kintana Release.

Feeds the Package Lines into the
Release Distribution Workflow.
Modeling Your Release Process in Release Management 21
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Workflow Design Considerations
The following sections list the restrictions related to each type of Workflow 
definition. Understanding these restrictions will help you design a functional 
set of Release-related Workflows. 

Release Distribution Workflow Restrictions
Release Distribution Workflows can be used to perform standard approvals 
and execute system commands. Certain Workflow functions are not, however, 
available for Distribution Workflows. These restrictions can be divided as 
follows:

• Workflow Step Source Restrictions

• Token Resolution

• Package Line Processing

Workflow Step Source Restrictions
Release Distribution Workflows consist of the standard types of Workflow 
Step Sources: Decisions, Conditions, Executions, and Subworkflows. When 
creating a Release Distribution Workflow, the following restrictions apply:

• Conditions: 
You can only use AND and OR Steps in Distribution Workflows.

• Executions: 
The following Built-in Workflow Events are not allowed in Distribution 
Workflows:

o wf_jump and wf_receive -- you can not use the Jump / Receive 
functionality within a Distribution Workflow.

o execute_object_type_commands -- you can not execute Object 
Type Commands. This processing is permitted in the Package-
Level Subworkflows.

o rm_ready_for_release -- you can not include a Ready for Release 
Step in the Distribution Workflow.

Token Resolution
Package and Package Line Tokens can not be resolved in Distribution 
Workflows. Package Token resolution occurs in the Package-Level 
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Subworkflows. So, as you add Notifications or Workflow executions to a 
Distribution Workflow, ensure that you are not using any Package or Package 
Line Tokens. If you need to resolve a Package or Package Line Token, you 
will need to do this in a Package-Level Subworkflow.

Package Line Processing
Release Distribution Workflows can not be used to process Package Lines. 
You must use a Package-Level Subworkflow to perform this level of 
processing. For example, you must use a Package-Level Subworkflow in your 
Distribution Workflow to execute Object Type commands. 

Package-Level Subworkflow Restrictions
Package Subworkflows that are marked as Use in Release Distributions can be 
included in a Release Distribution Workflow. Package Subworkflows that will 
be used within the Release Distribution Workflow scope have the following 
restrictions.

• Package-Level Subworkflows must be used for all Package Line 
processing. Package Token resolutions and Object Type command 
executions can only be run as Package Lines are processed through a 
Package-Level Subworkflow.

• Condition Steps: The SYNC Condition Step will not have any affect on the 
Distribution

• Execution Steps:

o wf_jump, wf_receive, and wf_ready_for_release can not be included in 
the Subworkflow

o You can not include Close Steps in the Subworkflow

Configuring Packages to Feed into a Release
Package Workflows can be configured to include a Workflow Step that will 
enable users to add Packages to a Release from the Package window. When 
Package Lines enter the Ready for Release Step, the Package can be added to a 
Release.
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You can add a Ready for Release Step to any Package Workflow or 
Subworkflow, except for Subworkflows that are designated for use in Release 
Distributions (Use in Release Distribution is selected in the Workflow window).

To add a Ready for Release Step to your Package Workflow:

1. Open the Package Workflow.

2. Drag the Ready for Release Step Source onto the Package Workflow's 
Layout tab. The Workflow Step window opens. 

3. If you want to require that Package users specify a Release at this point in 
the process, select Release is Required = Yes. To leave this as a non-
required field, select No.

4. Finish configuring the Workflow Step by entering other required and 
optional Workflow Step information, such as Security and Notifications.

5. Click OK.
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6. In the Layout tab, add transitions to and from this Workflow Step.

When Package Lines enter this Workflow Step, any user with permission to act 
on that Step can add the Package to a Release. You can then configure the 
Workflow to either proceed automatically or wait until the Release feeds a 
result back to the Package (see “Completing the Distribution” on page 50). 

A Workflow Step that would automatically proceed to the next Step in the 
Package Workflow could be configured as follows:

[Ready for Release] --> {transition = All Results} --> [Close]

A Workflow Step that would proceed to the next Step only after receiving 
feedback from the Release Distribution could be configured as follows:

[Ready for Release] -> {transition = Confirmed (or other Validation value)} -> 
[Close]

To make this transition meaningful, it must be coordinated with the 
Distribution. As a Release Distribution is processed, the Release Manager will 
decide when to feed a result back to the Packages in the Release. This value is 
sent from the Distribution window. Select the value from the Feedback drop 
down list and click Feedback -->.  The Ready for Release Step will then 
continue processing based on the resulting feedback. 

The Ready for Release Step's transition values must match the values in the 
Feedback drop down list. This is set in the RM - Ready for Release Validation.
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Defining a Release Distribution Workflow
The process for creating a Distribution mirrors the processes for creating 
Package and Request Workflows. A Release Distribution Workflow only 
differs with a few minor settings in the Workflow definition. There are also a 
few rules affecting which types of Workflow Steps can be included in the 
definition that will impact your design. 

In addition to regular Workflow Steps, a Distribution Workflow can contain 
two different types of subworkflows: 

• Distribution-Level:
These subworkflows act as continuations of the Distribution Workflow, 
processing the Distribution through a series of Decisions and executions.

• Package-Level:
These subworkflows are used to run every Package Line in the 
Distribution. All Package and Package line processing and execution 
happens here.

The following instructions highlight how to create the Distribution Workflow 
and the two types of Subworkflows. 

To create a Release Distribution Workflow:

1. Click New Workflow in the Workflow Workbench.

2. Select Release Distributions from the Workflow Scope drop down list.

3. Add Workflow Steps to the Layout tab.

a. Select Release Distributions from the drop down list in the Workflow 
Step Sources window.

b. Add Workflow Steps by dragging them to the Layout tab. Certain 
Workflow Step sources can not be added to a Distribution Workflow. 
See “Release Distribution Workflow Restrictions” on page 22 for 
information on these restrictions. 

c. Add any Subworkflows (Distribution-Level or Package-Level) to the 
Layout tab. See “Adding Subworkflows to Distribution Workflows” on 
page 29.

d. Add transitions between the Workflow Steps.

4. Save the Workflow.
26 Modeling Your Release Process in Release Management



Configuring a Release Management System
Defining Package-Level Subworkflows for Use in 
Release Distribution Workflows

Package-Level Subworkflows can be created and included in your Distribution 
Workflow to perform all Package Line processing. The following abbreviated 
process highlights the required settings for defining this type of Workflow. To 
create a Package-Level Subworkflow:

1. Click New Workflow in the Workflow Workbench.

2. Select Packages from the Workflow Scope drop down list.

3. Select Subworkflow = Yes.

4. Select Use in Release Distributions = Yes.

5. Add Workflow Steps to the Layout tab.

a. Select Packages from the drop down list in the Workflow Step Sources 
window.

b. Add Workflow Steps by dragging them to the Layout tab. Certain 
Workflow Step sources can not be added to a Package-level 
Subworkflow. See “Package-Level Subworkflow Restrictions” on 
page 23 for information on these restrictions. 

c. Add transitions between the Workflow Steps.

6. Add a Return Execution Step to the Layout tab (Workflow Event = 
wf_return). For a Package Line to transition back to the parent Workflow, 
the Subworkflow must contain a Return Step. The transitions leading into 
the Return Step must match the Validation established for the Subworkflow 
Step. See the “Advanced Workflow Configuration” section in Configuring 
a Deployment System (Change Management).

7. Save the Workflow.
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Example: Branching in a Process Based on a Token
You can configure the Package-Level Subworkflow to “branch” its process 
based on whether a Package contains a SQL Script object (Object Type = SQL 
Script) or an RCS Server File (Object Type = RCS Server File). This means that 
the result of a Workflow Step will depend on the Object Type name.

To configure a Workflow Step to branch based on the Object Type:

1. Create a Workflow Execution Step that will evaluate the Package Line 
Token for the Object Type. The Step should be configured with the 
following settings:

• Execution Type = Token

• Validation = DLV - Object Type - Enabled

• Execution = Token

You can also initiate the Package-level Subworkflow process from the 
Workflow Step Sources window. 
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2. Add the Step to the Workflow and set the transitions out of the Step. Using 
the above set-up, you can select any enabled Object Type as a transition 
value. 

When a Package Line enters the Evaluate Token - Object Type Name Step, the 
[PKGL.OBJECT_TYPE] Token will be resolved and the Package Line will be 
routed accordingly. 

Adding Subworkflows to Distribution Workflows
Subworkflow Steps can be added to a Distribution Workflow using the 
standard Workflow creation processes. This section highlights the required 

Branching based on a Package or Package Line Token must occur in the 
Package-Level Subworkflow. Package and Package Line Tokens are not 
resolved in Release Distribution Workflow Steps.
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settings and process for adding a Subworkflow to a Release Distribution 
Workflow.

Subworkflows are added to a Workflow by dragging and dropping the 
Subworkflow from the Workflow Step Sources window. Subworkflows that are 
configured for use in Release Distributions appear in either the Distribution-
Level or Package-Level directories shown below.
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Creating a Release

You can establish a new Release by clicking the New button on the Release 
Workbench. A new Release should be created as soon as it is known that the 
Release is needed. This allows for the addition of Packages or Requests at any 
point during the Release Cycle. 

The following sections provide instructions for engineering your Release:

• “Establishing a Release” on page 31

• “Adding a Package” on page 33

• “Adding a Request” on page 38

• “Verifying the Release” on page 41

• “Copying an Existing Release” on page 42

Establishing a Release
Setting up a successful software or application Release requires a 
comprehensive view of the Release process. Release Management provides the 
tools for capturing the entire Release process. See “Using Release 
Management - Process Overview” on page 16 for an overview of the items and 
processes involved in creating a Release.

One of the first Steps in establishing a controlled Release is to create a new 
Release in the Release Workbench. To create a Release:

1. Click the Change Management screen group and click the Releases icon. 
The Release Workbench opens.
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2. Click on New Release on the Release Workbench or select File -> New 
Release from the menu. The Release window opens.

3. Enter a Release Name and any additional general information that you 
would like to help define the Release. 

4. Add any Packages and Requests.

5. Define any Package dependencies.

6. Click Open Release to allow other Release Management users to add 
Packages and Requests to the Release.

7. Click Save to save the Release information.

Refer to the following sections for additional instructions on configuring your 
Release:

• “Adding a Package” on page 33

• “Adding a Request” on page 38

• “Dependencies and Run Groups” on page 14

• “Creating a Distribution” on page 45

• “Running Distributions through a Workflow” on page 47
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Adding a Package
There are four ways in which a Package can be associated with a Release:

• “Adding a Package Through the Release Window” on page 33

• “Adding a Package Through the Package Window” on page 35

• “Adding a Package by Acting on a Ready for Release Workflow Step” on 
page 35

• “Adding a Package from a Request” on page 38

Adding a Package Through the Release Window
When defining a Release in the Release window, the Release Manager may 
decide to manually add Packages to the Release.

In order to add a Package to a Release:

1. Navigate to the Release you would like to add a Package to.

2. Click Add on the Packages tab of the Release window. The Package 
Selection window opens.
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3. Enter any desired search criteria and click List. Packages matching your 
search criteria are dynamically listed in the Query Results list of this 
window.

4. Select the Packages to be added to the Release.

5. Click Add. If the Packages reference any other Packages or Requests, you 
will then be prompted to include or exclude them. 

6. Click Close after all desired Packages have been added. This will return 
you to the Release window which displays the newly added Packages.
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7. Click Save to save the Release information.

Adding a Package Through the Package Window
Users, other than the Release Managers, associate Packages with a Release 
through the Package window in Change Management. To add a Package to a 
Release, reference the Release through the Package References tab. 

The References window is shown in Figure 4-1.

Figure 4-1 Package Added to Release Through Package Reference

Adding a Package by Acting on a Ready for Release Workflow 
Step

Release Management provides a Ready for Release Workflow Step source 
which can add significant value to your Release process. When a Package Line 
reaches the Ready for Release Workflow Step and is executed, the status of the 
Package Line is changed to Confirmed. As soon as all of the lines in a Package 
are Confirmed, then the entire Package’s status becomes Ready for Release. 
Once an entire Package becomes Ready for Release, the Release Distribution 
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can feed back to each of its associated Packages so that each of them can 
transition to the next Workflow Step.

To act on a Ready for Release Workflow Step:

1. Navigate to the Package you wish to add.

2. Click the Package’s Status tab.

3. Select the Workflow Step to be acted upon. 

Workflows that are eligible for action are displayed in bold. Once an 
eligible Workflow Step is selected, the button at the bottom right of the 
Status tab will change its title (originally Action) to the name of the Step. 

You can reject the Ready for Release Workflow Step by choosing Bypass 
Execution or Override Status. This will stop the Package from getting 
released but will still allow it to continue through its own Workflow.
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4. Click Ready for Release. The Package Action window opens.

5. Select the Step’s result from the drop down list. You can also enter any 
relevant notes in this window.

6. Select the Release you want the Package to be associated with from the Add 
to Release auto-complete list. This field may be required, depending on the 
Workflow Step configuration (see “Configuring Packages to Feed into a 
Release” on page 23).

7. Once finished, click OK to save the result.
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The Package is now ready to be Released.

Adding a Package from a Request
When a Request that is included in a Release spawns a Package, that Package 
is automatically included in the Release. This becomes a powerful method for 
including Packages in a Release.

See Processing Packages (Change Management) for additional details.

Adding a Request
Requests can be added to a Release to track information associated with the 
Release. For example, the Release Manager may want to track which software 
bugs or enhancements (captured using Demand Management Requests) were 
implemented during the Release timeframe. 

There are two ways in which a Request can be associated with a Release:

• “Adding a Request Through the Release Window” on page 38

• “Adding a Request Through the Requests Window” on page 40

Adding a Request Through the Release Window
To add a Request to a Release from the Release window:

1. Navigate to the Release you wish to add a Request to.

2. Click the Requests tab.

3. Click Add. The Request Selection window opens.

A Development Manager can include a Request to fix a software bug in the 
Release. That Request’s Workflow can be configured to automatically create 
a Package to migrate changes into production. That Package will 
automatically be included in the Release.
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4. Enter search criteria and click List. Requests matching your search criteria 
are dynamically listed in the Query Results list of this window.
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5. Select the Request to be added to the Release.

6. Click Add. If there are any referenced entities, you will then be prompted to 
include or exclude them. 

7. Click Close. This will return you to the Release window which displays the 
newly added Request.

8. Click Save to save the Release information.

Adding a Request Through the Requests Window
Users, other than the Release Manager, must associate a Request with a 
Release through the Request page in Demand Management. 

To add a Request to a Release:

1. Navigate to the Request you wish to add to the Release.

2. Click the References section. 

3. Select Release from the New Reference drop down list and click Add. The 
Reference Release window opens.

4. Select the desired Release from the Release auto-complete list. Only 
Releases that the Release Manager has opened by clicking Open Release 
will appear in the Release list.

Users can only add Requests to an Open Release. Once the Release reaches 
the Code Freeze or Closed state, Requests can only be added by the Release 
Manager from the Release window.
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Verifying the Release
When you finish assembling the Release (Packages, Requests and setting 
Dependencies), you can verify that your Release is properly configured. 

To verify your Release:

1. Navigate to the Release you wish to verify.

2. Click Verify in the Release window. The Verify Release Properties window 
opens.

3. Select the property that you would like to check for from the drop down 
list. The verify options include:

• Check for Packages without Lines

• Check for Packages without Associated Requests

• Check for Packages without Associated Packages

• Check for Dependencies not in the Release

• Check for Circular Dependencies

4. Click Submit. Any errors will be reported in the window.

5. Click OK to close the Verify Release Properties window.
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Copying an Existing Release
You can create a new Release by copying and editing an existing Release. To 
copy a Release:

1. Click the Change Management screen group and click the Releases icon. 
The Release Workbench opens.

2. Locate and select the Release to be copied in the Results tab of the Release 
Management Workbench.

3. Click Copy. The Copy Release window opens.

4. Enter the new Release Name and click Copy. A Question dialog opens.

5. Click Yes to edit the Release.
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6. Enter the new Description and add any additional information that you 
would like to capture in the Release. You can add additional Packages, 
Requests, Notes, References, etc.

7. Click Save to save the Release Information.
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Processing a Release

The following sections provide instructions for processing Release 
Distributions:

• Creating a Distribution

• Enabling / Disabling Package Lines in a Distribution

• Running Distributions through a Workflow

• Completing the Distribution

Creating a Distribution
A Distribution is a deployment of a Release. In a Distribution, the Release 
Manager specifies which Workflow will control the Release process and which 
of the Release’s Packages will be included. See “Role of Workflows in Release 
Management” on page 10 for more information.

To create a Distribution:

1. Navigate to the Release you wish to create a Distribution for.

2. Click the Distributions tab.
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3. Click New. The Distribution window opens.

4. Enter the new Distribution Name and Description.

5. Select the Workflow that you would like this Distribution to follow. See 
“Role of Workflows in Release Management” on page 10 for additional 
information.

6. Select any Packages to disable and click Enable/Disable. Disabled 
Packages will appear in italics.
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7. Click Submit to run the Distribution through the Workflow specified.

The Release will begin running along the assigned Workflow.

Enabling / Disabling Package Lines in a Distribution
To disable a Package Line in a Distribution:

1. Open the Distribution from the Release’s Distribution tab.

2. Click the Package Status tab.

3. Locate the Package Line that you want to disable. Click the expand Run 
Groups button (  ) to display all of the Packages. Note that the Packages 
may be filtered. You may have to change your filter to show the desired 
Package.

4. Select the Package Line to disable. You can also select to disable an entire 
Package. Disabling a Package Line in an active Run Group (within a 
Package-Level Subworkflow) will cancel the Package Line.

5. Click Disable. The disabled Package Line is displayed in italics.

Running Distributions through a Workflow
The last Step involved in creating a Release is running the Release through a 
Change Management Workflow. Running the Release through a Workflow 
implies running any decisions, commands, Token evaluations, or other tasks 
for the Distribution as a whole. 

You can re-enable the Package Lines by selecting the lines and clicking 
Enable. If you disable a Package Line in an active Run Group, you can’t re-
enable the Line until the Run Group completes. If the disabled Package Line 
was not in an active Run Group, you can re-enable it immediately. 
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Processing the Distribution requires that you process Steps in both the 
Distribution Status and Package Status tabs.

Processing Distribution Steps
Active Workflow Steps appear in bold text. Select the active line and click the 
Action button to process that Step. From the Distribution Status tab, you can 
expand and act on all Distribution Steps (including Distribution-Level 
Subworkflow Steps). To process Package Lines, you must use the Package 
Status tab.

Figure 5-1 Distribution Status Tab

Processing Package Lines
Package Lines can be processed individually or in groups. Package Lines that 
are available for your action appear in bold text. Select an active Package Line 
and click the Action button to process that individual Step. 

Release Management provides a convenient interface for processing groups of 
Package Lines (in the same Workflow Step) simultaneously. This is done by 
viewing and selecting the Package statuses.

To select all Package Lines within a Workflow Step of a particular status:
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1. Open the Distribution’s Package Status tab.

2. Expand all Run Groups and Workflows.

3. Click the plus sign ( ) in the Description column. This displays a status 
summary of all the Package Lines in each Workflow Step. 

Figure 5-2 Package Status Tab

4. Select the summary. Again, items that are available for your action appear 
in bold text. When you select the summary, all Package Lines in that state 
are automatically selected. You can deselect individual items using Ctrl + 
click. 

5. Click the Action button to process all of the selected Package Lines. 

6. Proceed to the next Step in the Package process or Distribution process 
(depending on your pre-configured process). To view updates in the 
Distribution Status tab, click on the Distribution Status and click Refresh.
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Completing the Distribution
When the Distribution completes and the Workflow closes, a value can be 
returned to the Ready for Release Workflow Steps. Those Packages can then 
continue to process based on that Validation. That value is sent by clicking 
Feedback in the Distribution window.
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Viewing Relevant Release Data

All Release Management users with Change Management power licences can 
view Releases. Because hundreds of Packages and Requests can be included in 
each Release, users may want to limit which Packages and Requests are 
displayed. This will help them locate and monitor only Packages that are 
meaningful to their work. For example, a Programmer can display only the 
Packages that he created. 

This filtering is performed in the Release window in the Packages and 
Releases tabs using the Filter button.

The following topics are covered:

• Filtering the Displayed Packages

• Filtering the Displayed Requests

• Editing Packages and Requests

Filtering the Displayed Packages
To filter which Packages are displayed in the Release window’s Packages tab:

1. Open the Release.

2. Click Filter in the Packages tab. The Filter:Packages window opens. This 
window consists of two tabs: Basic and Advanced.
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The Basic tab is used to limit which Packages are displayed based on 
common Package fields, such as Package ID, Description, and Object Types. 
The Advanced tab provides an interface for filtering Packages based on the 
following:

• Package User Data fields

• Package Line User Data fields

• Object Type fields

3. Select the filter criteria from the Basic and Advanced tabs.

4. Click OK. Only the Packages matching the specified criteria are displayed.

Filtering the Displayed Requests
To filter which Requests are displayed in the Release window’s Requests tab:

1. Click the Requests tab in the Release window.

2. Click Filter. The Filter:Requests window opens. 
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3. Select the filter criteria.

4. Click OK. Only the Requests matching the specified criteria are displayed.

Editing Packages and Requests
Users can view Package and Request information in the Release Management 
window. All edits to those Packages and Requests are made in their respective 
product windows. For example, all changes to an associated Request must be 
made in Demand Management.

Release Management provides convenient access to these Packages and 
Requests. To open a Package or Request from the Release window:

1. Select the Packages or Requests from their respective tabs.

2. Click Open. The Packages or Requests open in their associated products.

3. Make any desired changes.

4. Click Save.

The updated Request or Package information is updated in the system, and also 
in the Release window.

Updated Package and Request information is not updated in existing 
Distributions. If you want the changes to be reflected in a Distribution, create 
a new Distribution.
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 Appendix

Release Management Screens and
Fields

This appendix describes screens and fields commonly used in Release 
Management.

Release Window
The Release window contains all of the information relevant to a Release. The 
Release window allows the Release Manager to manage and manipulate the 
Release in preparation for Distribution. See “Creating a Release” on page 31 
and “Processing a Release” on page 45 for more information on working with 
Releases.

The Release window is divided into six sections:

• “Release General Information Region” on page 56

• “Packages Tab” on page 57

• “Requests Tab” on page 61

• “Distributions Tab” on page 63 

• “Notes Tab” on page 70

• “References Tab” on page 71
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Figure A-1  Release Window

Release General Information Region
The Release General Information Region contains the common fields that 
define Release, such as the Release Name and the Release Status. Table A-1 
defines the fields included in the Release General Information Region.

Table A-1. Release General Information Region Fields

Field Description

Release Name The name of the Release.

Release Status The current status of the Release: New, Open, Code Freeze, or 
Closed.

Release 
Manager

The name of the Release Management user who has control 
over the particular Release. Only Release Management users 
that have the MANAGE RELEASES Access Grant will appear in this 
list.

Release Team The users who have access to the particular Release. This is a 
validated list of Security Groups and is used for informational 
purposes only.

Release Group A generic grouping of Releases which allows the Release 
Manager to group Releases into logical categories such as 
Customization.
56



Configuring a Release Management System
Packages Tab
The Packages tab is used to view, add, remove, set dependencies for, organize, 
and enable or disable Packages in a Release. In addition to the Packages 
already associated with a Release, new Packages may be added by the Release 
Manager through the Package Selection window. The Packages tab’s columns 
and buttons are defined in Table A-2.

Description The description of the Release.

Verify Accesses a utility to locate any inconsistencies in the Release 
definition. 

Open Release Enables other Release Management users to add Packages or 
Requests to the Release. 

Submit 
Release

Signifies the Release is ready to execute. Clicking the button will 
prompt the Release Manager to define a Distribution.

Close Release Changes the status of the Release to Closed. A closed Release 
cannot be reopened or edited.

OK Saves all changes to the database and closes the Release 
window.

Save Saves changes to the database but leaves the window open. The 
Save button is enabled only when unsaved changes exist.

Cancel Cancels any unsaved changes and closes the window.

Table A-1. Release General Information Region Fields

Field Description

The Packages tab is inaccessible for people without access to Change 
Management. Users who only utilize Demand Management have access to 
the Release Management Console but will not see the Packages tab.
57



Configuring a Release Management System
Figure A-2  Packages Tab

Table A-2. Packages Tab Columns and Buttons

Field
Description

Filter Opens the Filter:Package window where the user can select 
criteria to choose which Packages are displayed on the 
Packages tab.

Package ID Identification number associated with the Package.

Description The description of the Package.

Run Before Displays any Packages which must run before the Package listed 
in the Package ID column.

Run After Displays any Packages which must run after the Package listed in 
the Package ID column.

Status The status of the Package.

Origin The name of the Release to which the Package was originally 
added.

Added On The date that the Package was added to the Release.

Added By The name of the user who added the Package to the Release.
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Filter:Package Window
The Filter:Package window is used to limit which Packages are displayed on the 
Release Window’s Packages tab. This window is accessed by clicking the 
Filter button on the Packages tab.

The Filter:Package window consists of two tabs: Basic and Advanced. The 
Basic tab is used to limit which Packages are displayed based on common 
Package fields, such as Package ID, Description, and Object Types.

Add Opens the Package Selection window, where users can add new 
Packages to the Release. When adding a Package, the user is 
presented the option of also adding all referenced Packages and 
Requests.

Remove Removes a selected Package from the Release.

Enable/Disable Allows the Release Manager to keep Packages as references 
(disable), without blocking deployment of the Release. Disabled 
Packages are displayed in italics.

Dependencies Opens the Dependencies for Package window where 
dependencies can be defined for Packages in the Release. The 
Release Manager can configure Packages to run before or run 
after the selected Package(s). Also displays dependencies 
established by other Release Management users.

Refresh Refreshes the list of added Packages, returning it to its last saved 
state.

Open Allows the Release Manager to open the selected Package in 
Change Management.

Table A-2. Packages Tab Columns and Buttons

Field
Description
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Fields in this window are defined in Table A-2 on page 58.

The Advanced tab provides an interface for filtering Packages based on the 
following:

• Package User Data fields

• Package Line User Data fields

• Object Type fields

The Advanced tab functions in the same manner as the Advanced tab on the 
Workbench’s Query tab.
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Requests Tab
The Requests tab, shown in Figure A-3, is used to add, view and act on the 
Requests in a Release. Requests can be added to a Release by:

• Release Manager directly adding the Request through the Requests Tab

• Adding as a reference to a Package in the Release

• Referencing the Release from the Request window

See “Adding a Request Through the Release Window” on page 38 for more 
information on adding Requests to a Release.

The Requests tab’s columns and buttons are defined in Table A-3.

Figure A-3  Requests Tab

Table A-3. Requests Tab Columns and Buttons

Field
Description

Filter Opens the FILTER:REQUEST window where the user can select 
criteria determining which Requests are displayed in the Requests 
tab.

Request ID Identification number associated with the Request.

Description The description of the Request.
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Filter:Request Window
The Filter:Request window is used to select criteria determining which Requests 
are displayed in the Release’s Requests tab. See Configuring a Request 
Resolution System for definitions of these fields.

Child 
Packages

Displays all Packages that were created from the Request.

Request 
Status

The status of the Request. Statuses are configurable in Release 
Management.

Priority Displays the Request priority taken from the Request general 
information region.

Origin The name of the Release to which this Request was originally 
added.

Added On The date that the Request was added to the Release.

Added By The name of the user who added the Request to the Release.

Add Opens the Request Selection window where users can add new 
Requests to the Release. Adding a Request gives the option of 
adding all the related Packages and Requests.

Remove Removes a selected Request from the Release.

Refresh Refreshes the list of added Requests, returning it to its last saved 
state.

Open 
Reference

Opens the selected Request in Demand Management.

Table A-3. Requests Tab Columns and Buttons

Field
Description
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Distributions Tab
The Distributions tab, shown in Figure A-4, is used to view Distributions of a 
Release. Distributions are used to distribute a Release through a Workflow 
process. New Distributions are created by the Release Manager through the 
Distribution window, which is accessed through the Distributions tab. When a 
new Distribution is submitted, the Release runs through the associated Release 
Distribution Workflow. 

The Distributions columns and buttons are defined in Table A-4.

Figure A-4  Distributions Tab

Table A-4. Distributions Tab Columns and Buttons

Field
Description

Distribution The Distribution name. The name is defined in the Distribution 
window.

Description The description of the Distribution. The description is defined in the 
Distribution window.

Workflow The Workflow through which the Release Distribution runs.

Status The current status of the Distribution.

Submitted The submission status of the Distribution.
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Distribution Window
The Distribution window, shown in Figure A-5, is used to create a new 
Distribution for a given Release. This window includes two tabs:

• Distribution Status Tab:
Used to process the Release Distribution along the specified Workflow.

• Package Status Tab:
Used to enable and disable Package Lines included in the Release and view 
the progress of Package Lines as they are processed through any Package-
Level Subworkflows. Users can also use this tab to interact with individual 
Package Lines (for example, to reset a Package Line that has failed in an 
Execution Step).

This Distribution window is accessed from the Distribution tab in the Release 
window. The Distribution window fields and buttons are defined in Table A-5. 

Feedback 
Given?

Indicates whether feedback has been given to all Packages in the 
Release in a “Ready for Release” status.

NEW Opens the Distribution window where users can define a 
Distribution.

OPEN Opens the selected Distribution in the Distribution window.

COPY Copies the selected Distribution.

DELETE Removes the selected Distribution from the Release.

Table A-4. Distributions Tab Columns and Buttons

Field
Description
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Figure A-5  Distribution Window

Table A-5. Distribution Window Fields

Field
Description

Distribution 
Name

The Distribution name. The field defaults to the Release Name 
and Distribution Number.

Release The name of the Release to which the Distribution belongs.

Workflow Validated list of Release Distribution Workflows which can be 
used with the Distribution. Workflows must be enabled for use as 
a Distribution to appear in this field.

Distribution 
Status

The current status of the Distribution.

Description The description of the Distribution.

Distribution 
Status Tab

This tab is used to process the Release Distribution. Fields and 
buttons included on this tab are detailed in “Distribution Status 
Tab” on page 66.

Package Status 
Tab

This tab is used to process the Package Lines included in a 
Release. Fields and buttons included in this tab are detailed in 
“Package Status Tab” on page 68.
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Distribution Status Tab
The Distribution Status tab is used to process Distribution Workflow Steps. 
This can include activities ranging from approval Steps to Steps that 
automatically execute system commands. 

Submit Saves changes and begins to process the Distribution through the 
specified Workflow.

Feedback --> The Release Status which will be fed back to Packages in the 
“Ready for Release” state when the Feedback button is clicked.

OK Saves changes to the database and closes the Distribution 
window.

Save Saves changes to the database but leaves the window open. The 
SAVE button is enabled only when unsaved changes exist.

Cancel Cancels any unsaved changes and closes the window.

Table A-5. Distribution Window Fields

Field
Description

Note: Package Line processing (including Token resolution and Object Type 
command execution) happens in Package-Level Subworkflows. These Steps 
are tracked and processed in the Package Status tab.

Table A-6. Distribution Status Tab Fields

Field
Description

Seq The sequence number of the Workflow Step in the Release 
Distribution. Workflow Steps that are available for user action are 
denoted by an arrow located in this column.

Workflow Step 
Name

The name of the Workflow Step, Distribution-Level Subworkflow, 
or Package-Level Subworkflow
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Status The current state of the Workflow Step. This column indicates 
whether or not a Step is Approved, is Eligible for action or is still 
In Progress. If the word in the Status column appears in bold 
face type, then the user has the appropriate permissions to act 
on that eligible Step.
Note: Users can only directly process Distribution Workflow 
Steps from the Distribution Status tab. To act on Steps in a 
Package-Level subworkflow, use the Package Status tab.

User The username of the person that acted on a Step.

Date Initially, the Date represents the date that the Distribution entered 
that Workflow Step. When the Workflow Step has been acted on, 
the Date represents the date that the Request was acted on and 
left that Step.

Refresh Reloads the page with updates from the Package Status tab. 

Expand All Expands all of the Subworkflow Steps in the table.

Collapse All Collapses all of the Subworkflow Steps in the Workflow.

View --> Select an item from the drop down list and click View to see the 
information. Use this feature to view the following:

• Workflow Permissions

• Graphical View

• Distribution Transaction History

• Decision Detail

• Distribution Execution Log

• Latest Batch Execution Log

Action When a Workflow Step is selected, this button changes its name 
(originally Action) to the given Step name or Action button label 
defined for the Step. Click the button to process the Distribution 
through the Step.

Table A-6. Distribution Status Tab Fields

Field
Description
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Package Status Tab
The Package Status tab is used enable and disable Package Lines included in 
the Release and then process the enabled Packages through any Package-Level 
subworkflows included in the Release Distribution Workflow. All Package 
Line processing occurs using this tab. See “Running Distributions through a 
Workflow” on page 47 for details.

Figure A-6  Package Status Tab

Table A-7. Package Status Tab Fields

Field Description

Filter Opens the Filter:Packages and Package Lines window where you 
can specify which Packages in the Release are displayed. 
Filtering does not add or remove Packages from the Distribution.

Package Lists all Packages included in the Release. Packages can be 
enabled or disabled by selecting and clicking Enable or Disable.

Description Description of the Package. 
Use the + and - symbols in this column this to show or hide the 
status summary of the Package Lines in each submitted Workflow 
Step. You can then select the summary line to mass-select all 
lines with that status. This is helpful when you want to process or 
override all Package Lines of a particular status. You can deselect 
individual items by using Ctrl + click.
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Filter: Packages and Package Lines
This window allows you to specify which Packages included in your Release 
are displayed in the Package Status tab. Filtering does not add or remove 
Packages from the Distribution. You can select to limit the displayed Packages 
and Package Lines based on any of the following criteria:

Expand / 
Collapse Run 
Groups

Expands or collapses all of the Run Groups on the Package 
Status tab. You can expand or collapse individual Run Groups by 
clicking the + or - sign in the Package column.

Expand / 
Collapse 
Workflows

Expands or collapses all of Workflow Steps of the Package-Level 
Workflows included in the Release Distribution Workflow. You can 
expand or collapse individual subworkflows by clicking the top of 
the subworkflow column (on the first subworkflow Step).

Enabled Enables the selected Package Line. By default, all Package Lines 
in a Distribution are initially enabled. Disabled Package Lines 
appear in italics. 

Disabled Disables the selected Package Line. Disabled Package Lines 
appear in italics. 

Refresh Refreshes the screen to recognize the updated Package 
information. 

View --> Select an item from the drop down list and click VIEW to see the 
information. Use this feature to view the following:

• Line Exec Log

• Package Exec History

• Graphical View

• Line Permissions

• Line Transaction History

• Decision Detail

Action When a Workflow Step is selected, this button changes its name 
(originally Action) to the given Step name or Action button label 
defined for the Step. Click the button to process Package Line 
through the Step.

Table A-7. Package Status Tab Fields

Field Description
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• Package No. 

• Description

• Object Type

• Object Name 

• Run Group 

• Enabled

Figure A-7  Filter:Packages and Package Lines

Notes Tab
The Notes tab contains the free-form notes attached to the Release. As a 
Release is processed through its Workflow, different users enter information 
relevant to the Release. As they enter information (using the New Notes section 
of this tab) and Save, this information is merged with the existing notes for the 
Release. The new information is placed at the top of the notes along with 
general information indicating the user and update time.

Releases with notes display an icon on the Notes tab. The Notes tab is shown in 
Figure A-8.
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Figure A-8  Notes Tab

You can view the current notes for the Release in the Existing Notes panel of the 
Notes tab.

References Tab
The References tab, shown in Figure A-9, contains a list of entities related to 
the Release. These references can be automatically generated as a Release 
travels through its resolution process or can be manually attached to the 
Release at any time. Releases with attached References will include an icon on 
the References tab. 

The types of valid references are listed in Table A-8.
71



Configuring a Release Management System
Figure A-9  References Tab

Table A-8. Valid References in the Reference Tab

Type Description

Attachment Attaches a file from your local machine to the current Release. 
The attached file is copied to the server and can then be 
accessed by other Change Management users. This feature is 
particularly helpful when you need to reference a document 
that is not already Web accessible.

Project Associates a Release with a Mercury ITG Project. A Project 
can be “Related To” a Release.

Release Associates a Release with another Release by referencing the 
secondary Release number. A Release can be “Related To” 
another Release. A Release can also be the “Parent” or “Child” 
of another Release.

Task Associates a Release with a Project Management Task. A 
Task can be “Related To” a Release.
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URL References documents from a Release. These documents 
must be Web accessible and are attached by entering the 
document’s Web address. Once attached, click on the Web 
address to open the document in your Web browser. The 
document must be in a format recognized by your Web 
browser (Word, Excel, etc.)

Use documents to include more detailed information than what 
can be included in the Release Notes, such as a screen shot 
for an application enhancement or a report specification for a 
New Report Package.

Table A-8. Valid References in the Reference Tab

Type Description

Unlike Packages which can have blocking (predecessor or successor) 
references, Release references can only be informational. 
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